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Introduction 

1. Introduction 
Thank you for purchasing the AC-525 Visual Access Controller Unit (VACU) 
and AS-525AV ViTrax PC software. 
The AC-525 is an advanced multi-door networked access controller coupled 
with a digital video server and cutting-edge DVR technology. The integrated 
panel supports two analog camera inputs. It has a built-in embedded Linux 
OS with web server, which enables advanced network communication 
options. The AC-525 streams video in ISO standard compliant MPEG-4 (SP) in 
complete synchronization with real-time access control data. 
AS-525AV ViTrax is a digital video recording and remote surveillance 
Client/Server suite for Microsoft® Windows XP. It supports major Network (IP) 
Cameras, and Directshow compatible devices such as USB cameras. 
AS-525AV ViTrax features a proprietary multimedia database, DVR Watchdog 
which restarts the server automatically in case of PC power failure recovery to 
resume local and remote data flows, and a Google Maps interface which 
lets you place mark cameras on actual maps for easy browsing. 
This manual explains how to install and use AS-525AV ViTrax PC software with 
the AC-525 Visual Access Controller Unit. For more information on the AC-525 
system, refer to the AC-525 Access Controller Unit (VACU) Hardware 
Installation manual. 

1.1 System Features 
AS-525AV ViTrax makes it possible to view every aspect of access control 
within a single site. The system includes a built-in software security system that 
controls access to the system database and logs all operations performed. 
Using AS-525AV ViTrax wizard, users can custom design the system to meet 
their specific needs. 

Software Security 
Access to AS-525AV ViTrax software is password controlled. It is possible to 
grant different operators restricted security rights with access to only specified 
elements of the system or with read-only access.  
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1.2 AS-525AV ViTrax Server and Client 
AS-525AV ViTrax software provides full video management for the AC-525 
and third party servers. The software package consists of two applications:  

• AS-525AV ViTrax Server 
• AS-525AV ViTrax Client software 

AS-525AV ViTrax Server 
AS-525AV ViTrax operates through a dedicated server computer, which 
communicates with the access control panels and can serve an unlimited 
number of network clients. 
AS-525AV ViTrax Server is a behind-the-scenes application that captures, 
processes, and records video before serving it to a local or remote AS-525AV 
ViTrax Client. 
Install AS-525AV ViTrax Server on the computer that controls the Access 
Control panels and manages the database. AS-525AV ViTrax includes a full 
suite of administrator functions, including the ability to view multiple local and 
remote sources, record video for local or remote playback later, export 
recordings to preserve and present as evidence, change video parameters, 
and manage the database.  

AS-525AV ViTrax Client 
AS-525AV ViTrax Client has a limited operation set, and can only send or 
receive information from Visual Access Control panels when AS-525AV ViTrax 
Server is operating and connected to the panel network. 
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1.3 System Specifications and Requirements 
The following are the system capabilities and the system requirements. 

AS-525AV ViTrax System Requirements 
Operating System Microsoft ®Windows 2000 

Windows XP Home 
Windows XP Professional, 
Windows Vista 
Windows Server 2003 x 64 

Motherboard Intel® 915, 945, and 965 Family especially for using 
Frame Grabbers capture boards 

Memory Intel® 945G Express Chipset with a minimum of 64 
MB memory 

HDD Depends on frame-rate, compression, and 
storage period desired 
250 GB recommended 

Network LAN card required for TCP/IP networking 
 

Database Features (DB) 
DB Format Microsoft® MSSQL and Proprietary Files – Password 

Protected 

Embedded PDF Files Most current Software and Hardware Manuals 

DB Backup Backup Now Option/ Clear All Now Option 
DB Export Config and/or Events – Selectable 
Backup and Restore 
Auto File Naming for Backups 
Automatic Backups 

DB Export Formats .mp4 and .avi file exports 

Database Retention Programmable Period 
 

Networks 
Supported Access Control 
Panel Models 

AC-525 
AC-525 with MD-IO84 I/O extension board or MD-
D02 Door Expansion Board 

Panel Networks Serial (RS-485) 
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Communication Interface TCP-IP 
 

Video Surveillance 
Server Mode Local Network and Remote network 

Server and Client module 

Streaming Support ISO Standard MPEG-4, Intel IPP 

Selectable Viewports Matix Viewports 

PTZF Presets Two per viewport support Pelco-D 
 

Video Recording Server 
Recording MJPEG/JPEG compression 

Scheduler Schedule Pre-and Post Alarm by date and time or 
by event 

Motion Detection Selectable Motion areas and Sensitivity in FOV 
Zones 

Advanced Compression Proprietary Storage with Custom Retrieval Tools 

CPU 
The recommended CPU depends on the number of cameras you connect to 
the system: 

 Number of 
Cameras 

Recommended 
CPU 

Recommended 
RAM 

Personal 1 P4 2.4 Ghz 256 MB 
Basic 4 P4 2.8 Ghz 512 MB 
Professional 9 PD 3.0 Ghz 768 MB 
Advanced 16 Core™2 Duo 1024 MB 
Enterprise unlimited Xeon®** n/a** 

** Contact Rosslare representatives to figure out the recommendations for the 
installation. 

 

Note: 
The AC-525 system is a multi-threaded application, so using 
multi-core CPU is strongly recommended. 
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1.4 How to Use this Manual 
This manual is constructed in a step-by-step format but can also be used as a 
quick reference guide.  
Installers who are new and unfamiliar with the setup procedure should read 
this manual from cover to cover and should read each chapter in the order 
that it is presented. However, if you are already familiar with AS-525AV ViTrax 
software, this manual can be used as a quick reference guide in order to fine 
tune the knowledge about AS-525AV ViTrax system. 
A PDF of this manual can also be found on AS-525AV ViTrax software 
installation CD. 

 

Note: 
This manual refers to AS-525AV ViTrax software version 1.6.6 
and above.  
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2. Installing AS-525AV ViTrax PC Software  
The installation of AS-525AV ViTrax PC software package from the CD-ROM is 
a mostly automated process done by a smart installer program. 
The installer helps with tasks such as entering a unique server name, 
administrator login setup, enabling access from remote AS-525AV ViTrax 
clients, TCP/IP port selection, and application running mode. You can always 
come back to this Wizard later to change the settings though the Start Menu. 
The software consists of two applications, AS-525AV ViTrax Server and AS-
525AV ViTrax Client. During the installation process, you are presented with a 
choice to install either both of the available applications or just one of them. 
AS-525AV ViTrax Server requires activation with the activation key provided 
when the product was purchased. The server can only be activated on one 
computer. If at a later date you need to move the installation to another 
computer, please contact Rosslare Technical Support on +972 3 938-6838 or 
email at support.eu@rosslaresecurity.com

 

Note: 
Please remember to keep your activation key in a safe 
place. If you do lose the activation key, it can be viewed by 
selecting About from the menu bar.  

 
AS-525AV ViTrax Client software does not require activation and can be 
installed on as many computers as you want. 

2.1 Connecting to the PC 
Before using the software, it is important to make sure the AC-525 hardware 
and any additional components, i.e. cameras, are connected correctly. 
Create a connection between the hardware and the computer. The AC-525 
is not connected directly to the computer but to the IP network.  
Please refer to the AC-525 Hardware Installation manual in order to configure 
the hardware to the computer. 

2.2 Starting AS-525AV ViTrax Installer 
Install AS-525AV ViTrax software using the installation CD-ROM. 

To begin installing AS-525AV ViTrax: 
1. Close all applications. 
2. Insert the CD into the computer's CD drive.  
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If AS-525AV ViTrax Setup Wizard does not start automatically, click Start 
on the Windows taskbar, and click Run. Enter D:\Setup, where D is the 
letter that corresponds to the CD drive. 
For example, if the CD drive is the E drive, enter E:\setup. 

3. Click Install to continue the installation. The Welcome to the Install Shield 
Wizard window opens. 

 
Figure 1: Welcome Rosslare Setup Wizard Window 

4. Click Next to display the Software License Agreement window. 
To cancel, click Cancel to quit AS-525AV ViTrax PC software installer. 

 
Figure 2: Software License Agreement Window 
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5.  After reading the Software License Agreement, choose Accept. Click 
Next to continue with the installation. 

6. Choose the Destination Location. 
The installer prompts you to enter the destination location for the 
installation. This is where AS-525AV ViTrax PC software is stored on the 
hard drive. 

 
Figure 3: Setup Destination Window 

7. Click Next to accept the default installation location and continue with 
the installation or click Browse to change the installation location. 

8. After selecting the new installation location, click Next to continue with 
the installation. The Install Components window opens. 

 
Figure 4: Install Components Window 
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9. Select the components you want to install. 
Check the ViTrax Server Application to select the server or check the 
ViTrax Client Application to select the client. 
If you want to be able to view and manage the server from the same 
machine, check both ViTrax Server Application and ViTrax Client 
Application. 

10. Click Next to continue with the software installation. 
11. Choose to place a shortcut for this application in the Start Menu Folder so 

that every time the host computer reboots, it automatically restarts the 
AS-525AV ViTrax software. 
This window allows you to select the Start menu folder. 

 
Figure 5: Select Start Menu Window 

12. Click Next to accept the default shortcut location and continue with the 
installation or click Browse to change the shortcut location. 
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Figure 6: Select Additional Tasks Window 

13. Check the relevant additional tasks as required and click Next to 
continue. 

 
Figure 7: Ready to Install Window 

All the installation settings are now entered. Installation can now begin. 
Click Cancel to cancel the installation, or, click Install to install AS-525AV 
ViTrax software.  
When the Setup Completed window appears, the software is successfully 
installed. By default, the Run server setup wizard (recommended) 
checkbox appears checked. If you do not want to launch the Server 
Setup Wizard at this stage, uncheck the box. 

14. Click Finish to exit the installer. 
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2.3 Installing the Server Configuration 
Before using the software, you must install the server configuration using the 
Server Setup Wizard and activate the software. 

To install the server configuration: 
1. In the last screen of the Rosslare Setup Wizard, make sure the Run server 

setup wizard (recommended) checkbox is checked. Click Finish.  
or 
From the Start menu, select Rosslare  Tools  DVR Server Setup Wizard. 
The Server Setup wizard opens. 

 
Figure 8: Server Setup Wizard Window 

This wizard guides you through the initial server setup. Before installing the 
server, you will be prompted to activate the software. 

 

Note: 
The introduction dialog box may or may not open 
depending on whether someone has checked the 
checkbox Skip introduction page next time. Therefore, the 
following dialog box will either open first or second in the 
Camera Setup Wizard. 

Activate the Software 
The software must be activated in order to use it and to ensure proper 
support. 
You can activate the software in the following ways: 
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Internet Activation 
Internet activation is the quickest and most convenient way to activate the 
software if the machine is connected to the Internet. 

Phone Activation 
Phone Activation is the other option to choose if you are not connected to 
the Internet to be able to activate the software. 

No Activation 
The No Activation option in the Activation Wizard uses the demo version of 
AS-525AV ViTrax. This option limits use of the software to Shareware use, which 
are only basic features and configuration capabilities. 

To activate the software via Internet or phone: 
1. Start AS-525AV ViTrax software from the Windows Start menu or click the 

AS-525AV ViTrax icon on the desktop. 
2. When the Rosslare Activation Wizard opens, click Next to continue the 

activation. The Product Activation Method window opens. 

 
Figure 9: Product Activation Method Window 

3. To activate the full version of the software, select Internet Activation if the 
machine is connected to the Internet or Phone Activation if the machine 
is not connected to the Internet. 

4. Click Next to continue the activation.  
If you selected the Internet Activation option, the Activate Product over 
Internet window opens. 
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Figure 10: Activate Product over Internet Window 

5. Enter the activation key that is found on the software disk.  
If you selected the Phone Activation option, the Product Activation over 
the Phone window opens. 

 
Figure 11: Activation Wizard Window 

6. Call a Rosslare representative at +972-3-938-6838 to be provided with the 
Confirmation Key. 

7. Enter the Activation Key in Step 2 on the screen. You can find the 
Activation Key on the software disk. 

8. Provide the system ID that appears in this window to the customer service 
representative on the phone. 
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9. Enter the Confirmation Key provided by the customer service 
representative on the phone in Step 4 on the screen. 

10. Click Next to continue with the activation. The activation finishes. The 
Activation Completion window displays the description of the edition 
and the access limitations. 

11. Click Finish to exit the activation wizard and continue installing the server 
configuration. 

To select the No Activation option: 
1. Follow steps 1 and 2 in the above activation process. 
2. Once the Product Activation Method window opens, select. No 

Activation (continue using Shareware version). 
3. Click Finish to exit the Activation Wizard and continue installing the server 

configuration. 

Install the Server Configuration 
After activating the software, continue installing the server configuration. 

To install the server configuration: 
 1. Specify the server properties, such as unique identifier, title, and 

database settings in the Server Properties window. 

 
Figure 12: Server Properties Window 

Enter the Server ID and Server Title. 
Choose the destination location for the configuration database. 
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Check the Compact the configuration database checkbox to optimize 
the configuration database in the future. 

2. Click Next to continue the Server Setup Wizard. The Server Administrator 
Settings window opens. 

 
Figure 13: Server Administrator Settings Window 

This window determines the settings for the Administrator. Leave the 
default user name to admin and enter a unique password in both lines. 
You can add additional users at a later time. 

3.  Click Next to continue with the Server Setup Wizard. 
4.  Determine the Server Network and Port Settings. 

 
Figure 14: Server Network and Port Settings Window 
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The default firewall port that the Rosslare uses is 60554. You can change it 
to any port as long as it is open on the firewall. Check with the network 
administrator or internet service provider about the appropriate firewall 
settings. 

5.  Click Next to continue with the Server Setup wizard. The Server Execution 
Mode window opens. 

 
Figure 15: Server Execution Mode Window 
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This window has two options: 
• Application mode — starts the program manually via three options in 

the dropdown menu: 

o Manually — double-click the program to get it 
started 

o Automatically with any user logon — initiates the 
software on when any user logs into Windows on 
that machine 

o Automatically with current user logon — the user 
currently logged into Windows is the user that 
activates AS-525AV ViTrax upon Windows login 

• Service Mode — the software always runs in the background even 
though nobody has yet logged into Windows. This means you can lock 
everyone out of Windows and never have to worry about any of the 
data. Also, if the power ever goes out, upon power recovery, the 
system turns on and nobody needs to physically log into windows or 
turn AS-525AV ViTrax software on in order to keep the data flowing 
both locally and remotely. 

 

Note: 
The Service Mode is the recommended option.  

 
If AS-525AV ViTrax software is setup on Service Mode it can be stopped 
by browsing the windows services or by using the DVR Server Setup 
Wizard. (See Step 1 above). 

6. Click Next to continue with the Server Setup wizard. The Server Execution 
Control window opens. 
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Figure 16: Server Execution Control Window 

The options shown here depend on the choice made in the previous 
screen. Choose to either Start Server Application or Start Server Service. 

7. Click Next to continue with the Server Setup wizard.  
8. When the Wizard Completed window appears, click Finish to exit the 

installer. The DVR Server has been successfully installed. 

2.4 Adding the Server to the Client  
Before using AS-525AV ViTrax software, you must add the server information to 
the client application. 

To add the server information: 
1. Double-click the ViTrax Client connection icon 

on the desktop. The main screen is displayed. 

 

Note: 
A Warning dialog box appears, stating that there are no 
video cameras found on the local server.  If you click Yes, 
the software scans for cameras using auto detection (in the 
Network Scan Wizard). This option is only applicable for IP 
cameras. If you click No, you can add the cameras 
manually (in the Camera Setup Wizard). Click Cancel so 
you can continue adding the server to the client. 

 
2. From the Server menu, click Server and then Add Server.  
3. When the Add New Server Wizard appears, click Next. The Adding New 

Server window opens. 
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Figure 17: Adding New Server Window 

The following data is added in this window: 
Server IP Address The IP or the DNS of the server you 

want to connect. 
If the server is on the same machine, 
type localhost. 

Server Port The port the server is running on. 
User Name Enter username. 
Options:  

• Remember password If you choose to leave this field 
unchecked, the server requests a 
password every time you log on . 

• Auto connect on start Selecting this option auto connects 
to the server as soon as you open 
the Client. 

• Auto reconnect on 
disconnection 

Selecting this option instructs the 
program to automatically reconnect 
you in the event of disconnection. 

Server Title Enter server title 
4. To continue adding a server, click Next. The Wizard Completed window 

opens. Click Finish. 
5. Click File and then Save As. 
6. Click the Desktop icon to select Desktop in the Save in line. 
7. Find the ViTrax Client and highlight it so the name appears in the Save in 

line.  
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8. When the program asks to override the client which already exits, click 
Yes. 

 

Note: 
If you do not click Yes, the new server is not saved in the 
server list on the left and you have to re-enter the 
information when you reopen the program. 

 
The client installation is now complete. You now have video feed from 
the connected cameras. 
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3. System Overview 
AS-525AV ViTrax is controlled through an easy to use interface featuring: 

• a tree-view list of all aspects of the site set-up 
• a toolbar for standard operations 

3.1 Initiating AS-525AV ViTrax 
This section explains how to start the software and login to the main window. 
1.  Before you start AS-525AV ViTrax software, you must first turn on the 

server. Select from the Start menu  Programs  Rosslare  DVR Server or 
double-click the icon below found on the Windows desktop. 

 
Figure 18: DVR Server Icon 

2.  Once the server is connected, you can start AS-525AV ViTrax software. 
Select from the Start menu  Programs  Rosslare ViTrax Client or 
double-click the icon on the Windows desktop. 

 
Figure 19: AS-525AV ViTrax Access Control System Icon 

The Authorization dialog box for the remote server opens. 

 
Figure 20: Authorization Dialog Box 

3. Type the password you chose in the Server Setup Wizard. Click Logon to 
have access to AS-525AV ViTrax.  
AS-525AV ViTrax Client main window opens. 
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3.2 AS-525AV ViTrax Main Window 
All the central functionality of AS-525AV ViTrax is available from its main 
window. 

 

 
 

 

 

 

 
Figure 21: AS-525AV ViTrax Main Window 

AS-525AV ViTrax is divided into six sections. 

 

Note: 
This screen is not the initial screen that appears upon start-
up. It is only used to better explain the system overview. 

 

 
 

Menu Bar Access to general operation and set up of the system 

 
 

Toolbar Contains icons for key management tasks 

 
 

Structure 
Pane 

Configure, monitor, and control client and server 
elements in the system 

 
 

Display Pane Displays the hierarchy of the selected element 
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Events Pane Lists the time and date record of server-client connection 

 Status Bar Displays general status information such as system 
readiness and screen layout sequence options. 

3.3 Menu Bar 
Access to the general operation and set up of the system is through the 
menu bar. It contains menu options such as the file, view, server, video, tools, 
and help menus. 

File 
Manage the client files by clicking on tasks in the menu bar, by pressing the 
shortcut keys on the keyboard, or by clicking the related toolbar icons, when 
applicable. 

New 
 

Creates a new AS-525AV ViTrax client file with the file 
extension of .lxd.  
Access this task on the keyboard with shortcut key Ctrl-N. 

Open Opens previous AS-525AV ViTrax configuration files. The 
video stream of the selected file displays in the Display 
Pane. 
Access this task on the keyboard with shortcut key Ctrl-O 
or by clicking the Open Configuration icon on the 
toolbar. (See Toolbar on page 35.) 

Save 
 

Saves current client configuration file.  
Access this task on the keyboard with shortcut key Ctrl+S 
or by clicking the Save Configuration icon on the toolbar. 
(See Toolbar on page 35.) 

Save As Saves the client configuration to a different file or even to 
a floppy. 

Recent 
Files 

Displays path of recently opened client files. 

Exit Closes AS-525AV ViTrax Client. 

View 
Select the items you want to see in AS-525AV ViTrax window through the view 
menu bar options such as toolbars frequently used and the preferred screen 
arrangement in the Viewing Pane. 

Page 26 AS-525AV ViTrax Software Installation and User’s Guide 
 



System Overview 

Toolbars 
Choose to view or hide the following toolbars: 

• Standard —contains most commonly used tasks and functions 
• Screen Arrangement —manipulates the views and camera layouts 

to the own preference 
• Screen Control —manages video streams and camera view 

choices in the Display Pane 
Panes 
Toggle between viewing and hiding the following panes in AS-525AV ViTrax 
window: 

• Structure —the pane that is visible on the left side of AS-525AV ViTrax 
window. It is the control center of the system and is most useful 
when you are looking at cameras from multiple locations and 
multiple AS-525AV ViTrax servers (see Structure Pane on page 37). 

• Events —the pane that is visible on the lower half of AS-525AV ViTrax 
window. It gives the important notifications such as when you are 
connecting to a server successfully, lets you know if you have input 
improper user names and passwords, and gives you error codes 
when needed. 

• PTZ Control —controls the PTZ tasks if you have a PTZ compatible 
camera attached to the system.  

 

Note: 
PTZ capabilities are not supported in this version. 

• Video Adjustment —the pane that contains tools to adjust every 
individual camera with its own settings (see Making Video 
Adjustments 

 
Status Bar 

This bar displays general status information such as system readiness and 
layout sequence options.  

Click the Manage Layout Sequences icon  to access the Manage Layout 
Sequence feature (see Creating Custom Layouts 
 

Full Screen 

In full screen, none of the panes are seen and the cameras expand to their 
maximum size to fill the full screen of the monitor. 
Access this feature from the View menu, the F11 shortcut key on the 
keyboard, or by clicking on the Full Screen icon on the toolbar (see Toolbar 
on page 35). 
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Minimize full screen view by pressing the F11 shortcut key on the keyboard or 
by clicking Exit in the Full Screen dialog. 

 
Figure 22: Full Screen Dialog 

 
Always on Top 
Enabling this feature prevents other application windows from opening on 
top of AS-252 ViTrax Client windows until you uncheck Always on Top.  

 
Screen Arrangement 
This feature allows you to manipulate the views and camera layouts to your 
own preference. 

Equal Size Screens 
This feature displays the screens in the Display Pane in a designated number 
of equal size screens. 

 
Figure 23: Screen Arrangements 
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Large Size Screens 
This feature displays the screens in the Display Pane in a designated number 
of equal size screens with 1-2 large screens. 

 
Figure 24: Large Screen Arrangements 

Maintain Aspect Ratio 
When enabled, this feature maintains the correct proportions of the images 
appearing in the Display Pane screens. 
 

Screen Details 
Select the details you want to appear on each of the screens in the Display 
View with the following preferences: 
Show Screen 
Footer 

Displays footer under each screen in the Display 
Pane. 
Access this task on the keyboard with shortcut key 
Alt+Shift+O.  

Show Current 
Frame Time 

Shows current frame time of the displayed image in 
the screen footer of selected screens. 
Access this task on the keyboard with shortcut key 
Alt+Shift+T. 

Show Image 
Resolution 

Shows the resolution of the displayed image in the 
screen footer of selected screens. 
Access this task on the keyboard with shortcut key 
Alt+Shift+R. 
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Show Average 
Image Size per 
Frame 

Shows the average image size per frame of the 
displayed image in the screen footer of selected 
screens. 
Access this task on the keyboard with shortcut key 
Alt+Shift+Z. 

Show Average 
Frame Rate per 
Second 

Shows the average frame rate per second (fts) of the 
displayed image in the screen footer of the selected 
screens. 
Access this task on the keyboard with shortcut key 
Alt+Shift+F. 

Digital Pan-Tilt-
Zoom 

This feature does not work in this version. 

Show Detected 
Motion 

Shows motion detection of the displayed image in the 
selected screen. 
Access this task on the keyboard with shortcut key 
Alt+Shift+M. 

Hide Detected 
Motion for All 
Screens 

Hides motion detection in all displayed screens. 

 
Time Presentation 
Choose between the following time preferences: 

• Local Time 
• UTC Time (Coordinated Universal Time) 
• Server Local Time 

Save Current Layout 
The Layouts feature group cameras from different AS-525AV ViTrax 
servers/locations into groups for more efficient monitoring and better 
management. You can select this option to save the currently selected 
layout. 
View and select the available layouts in the Structure Pane tree-view. The 
selected view displays in the Display Pane (see Creating Custom Layouts on 
page 90). 
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Manage Layouts 
This feature allows you to set the preferences on all the layouts. 
Also access this option by clicking the Manage Layouts icon in the Structure 
Pane (see Creating Custom Layouts on page 90). 

Deactivate Layout Sequences 
This feature deactivates layout sequences. 

Manage Layout Sequences… 
When layouts are created, they can be used for creating video sequencing 
through the Manage Layout Sequences feature. This can be used to define 
which layout is activated upon startup. 
Also access this feature by clicking the Manage Layout Sequence icon in the 
Structure Pane (see Creating Custom Layouts on page 90). 

Manage Maps 
This feature allows you to quickly and conveniently locate cameras for 
viewing placed on Google Map™ and/or on the own JPEG map (see Map 
Module Feature on page 94). 

Server 
Manage the servers by clicking on Server in the menu bar or by pressing the 
shortcut keys on the keyboard, when applicable. 

Add Server 
This menu option launches the Add Server Wizard (see Adding the Server to 
the Client on page 21). 

Remove All Servers 
This menu option removes all server connections.  
Upon selection, the system asks you to confirm your choice to remove the 
server connection. 
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Selected Servers 
Manage the servers with the following options in the submenu:  
Connect Connects to a selected server 
Reconnect Reconnects to a selected server 
Disconnect Disconnects from a selected server 
Refresh Updates the server connection 
Tasks Manages and configure server and camera options with 

the following: 
• Server Security Setup Wizard 
•  Manage Server Security 
• Camera Setup Wizard (see Configuring Cameras on 

page 52.)  
• Video Frame Export Setup Wizard (see Exporting Video 

Frames on page 84) 
• Open Archive (see Archiving Integrity Wizard on page 

97) 
• Manage Watchdogs (see Server Configuration on page 

39) 
• Recording Properties (see Server Configuration on page 

39) 
• TCP Communication Properties (see Server 

Configuration on page 39) 
• Backup server’s archive data (see Archiving Backup 

Wizard on page 99) 
• Find Arecont Vision Network Cameras (see Setting up 

AC-525 Connection on page 52.) 
• Find Network Cameras (see Network IP Cameras on 

page 68) 
Refer to the AC-525 Hardware manual to see a list of 
compatible cameras. 

Move Up Scrolls up if you have multiple servers 
Move Down Scrolls down if you have multiple servers 
Remove Removes server connection 
Properties Sets server preferences 

Connect All Servers 
This feature connects all servers on the system. 
Access this feature on the keyboard with shortcut key Ctrl+Shift+C. 
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Disconnect All Servers 
This feature disconnects all servers from the system. 
Access this feature on the keyboard with shortcut key Ctrl+Shift+D. 

Manage Servers 
Add, remove, configure, and connect or disconnect the servers with this 
feature. 

Video 
The video menu options manage the video properties of the images 
displayed in the Display Pane. 

Stream 
This feature enables you to pick which camera you want to view in the 
selected camera window. 

Transfer 
This feature sets the video transfer rate, bandwidth controlled broadcast time, 
motion control video transfer rate, and recompression properties (see 
Enabling Video Transfer on page 88). 

Digital-Pan-Tilt-Zoom 
This feature enables you to select, drag, and zoom in/out of the displayed PTZ 
camera image in Displayed View. 

 

Note: 
PTZ is currently not supported in this version. 

 
Also access this feature from Screen Details in the View menu choice.  

Show Detected Motion 
This feature shows motion detection of the displayed image in the selected 
screen in the Display Pane. 
Also access this feature from Screen Details in the View menu choice.  

Properties 
This feature shows camera properties of the screen selected in the Display 
Pane. 

Maximize 
This feature toggles between current Display Pane view and an enlarged 
view of a selected screen across the whole Display Pane area.  
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Copy Current Frame to Clipboard 
This feature allows you to copy currently rendered video frame to Clipboard. 
Only the frame from a selected screen is copied. 

Save Current Frame As… 
This feature allows you to save currently rendered video frame to a file. Only 
the frame from a selected screen is saved. 
Also access this feature by clicking the Save Current Frame As icon in the 
toolbar. 

Unmap All Screens 
This feature allows you to unmap the video stream from the Display Pane. 
Also access this feature on the keyboard with shortcut key Alt+Shift+U. 

Automap Available Screens 
This feature allows you to automatically map the video stream to the 
available Display Pane. Also access this feature on the keyboard with 
shortcut key Alt+Shift+A. 

Tools 
The Tools menu options manage password access security, viewing files, and 
application options and preferences. 

Lock Application 
This feature locks the application until an exclusivity mode password is 
provided to unlock it. 
When you click on Lock Application, you are prompted to define a non-
empty exclusivity mode password. 

Utilities: 
This feature opens and plays selected media files. You navigate the Media 
File window by selecting the desired tool from Navigation in the menu bar or 
by clicking on VCR standard navigation icons in the Standard toolbar: 

Options 
This feature modifies settings for AS-525AV ViTrax such as screen options, 
screen mapping, exclusivity, and other options (see Setting System Options on 
page 77). 

Help 
The Help menu options provide options to help you accomplish tasks.  
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Rosslare on the Web 
This feature links you to the Rosslare website: www.Rosslaresecurity.com 

Problem Report Wizard 
This feature links you to a Problem Report wizard. The wizard prompts you from 
screen to screen. The final report is sent to a Rosslare service representative. 

About ViTrax Client 
This feature lists product information such as product version number, module 
version number, product activation key, website address, and email address.  

3.4 Toolbar 
The toolbar contains shortcuts to major menus and commands. Click on each 
icon to transition to the desired section. 
Standard Toolbar  

 
 

Open Configuration—This button on the toolbar allows you to 
open previous AS-525AV ViTrax configurations. It is most 
useful if you are exporting configurations from one 
machine to another. 

 
 
 

Save Configuration —This button on the toolbar allows you to save 
any changes that you have just made to the AC-525.I It continues 
to save to the same file unless you click on File and Save As; then 
you can save to a different file or even to external memory, e.g. 
USB 2.0 memory key. 

 
 
 

Structure Pane  — This button toggles between seeing and not 
seeing the structure pane on the left side of AS-525AV ViTrax 
window.  
Access this pane on the keyboard with shortcut key Alt+Shift+S. 

 

Events—This button toggles the events window.  
Access this pane on the keyboard with shortcut key Alt+Shift+E. 

 

 

PTZ Control  — This enables the Digital Pan-Tilt Zoom option. PTZ 
compatible cameras are currently not supported in this version of 
the software. 

 

Video amplification— This button toggles the video amplification 
pane. When this button is pressed, a pane opens from which you 
can adjust the brightness, contrast, saturation, sharpness, and hue 
for any camera.  
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Full Screen  — This button toggles full screen mode. In full screen, 
none of the panes are seen and the cameras expand to their 
maximum size to fill the full screen of the monitor.  

 
Open Archive — This button opens the archive viewer window. 
You can view archived data of the connected server. 

 
Manage Maps — This button toggles map module window for 
managing and viewing cameras on Google or previously added 
maps.  

 

Save Current Frame as — This button allows you to save currently 
rendered video frame into file. Only the frame from a selected 
screen is saved. 

 

Wizards — The wizards icon on the toolbar gives you a shortcut to 
various server, camera options, and configurations. You can also 
access these features through the right-click menus in the 
software.  

 
Screen Arrangement Toolbar 

 
 Views — These buttons (shown above) on the toolbar allow you 

to manipulate the views and camera layouts to your own 
preference. 

 

 
Screen Control Toolbar 

Screen Footer — This button allows you to display a variety of 
information beneath each camera window. It can display 
frame rate, time, picture quality, recording, motion detection, 
and image size. The screen footer is the text below each 
camera. 

 

 

Stream Selection — This button allows you to pick which camera 
you want to view in the selected camera window. This can also 
be done through the right-click menus and by dragging the 
desired camera from the structure pane to the desired display 
window, or by right-clicking on any camera window and 
selecting Stream. 

 

Show Motion — This button toggles between showing the 
motion outlined on the selected camera screen or not.  
Motion detection must be set up before this feature can be 
activated. 
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Maximize — When pressed, this button puts the selected 
camera into a single view. If pressed again it returns to the 
previous view. This can also be accomplished by double 
clicking on the camera of choice. 

3.5 Structure Pane 
The structure pane is the control center of the ViTrax AS-525. You set up the 
AC-525, the cameras, and all third party servers in the structure pane. In the 
structure pane it is also possible for you to manage many servers from one 
window by right-clicking on the server of the choice. 

 
Figure 25: Structure Pane 

Console Root Right-click to see the following options: 
• Standard Toolbar 
• Screen Arrangement Toolbar 
• Screen Control Toolbar 
• Structure Pane (toggles between viewing and hiding 

pane) 
• Events Pane (toggles between viewing and hiding 

pane) 
• Video Adjustment Pane (toggles between viewing 

and hiding pane) 
• Status Bar 

Servers Right-click to view the following options:  
• Add Server ( see Adding the Server to the Client on 

page 21) 
• Remove All Servers 
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• Connect All Servers 
• Disconnect All Servers 
• Sort Servers Alphabetically 
• Manage Servers  

Available 
servers sub-
menu 

Right-click on the server name to view the following 
options: 
• Connect 
• Reconnect 
• Disconnect 
• Refresh 
• Tasks: Remove, Move Up, Move Down, Properties 
Archive – Right-click to open Archive 

Layouts  
(See Creating 
Custom Layouts 
on page 90) 

Right-click to view the following options: 
• Save Current Layout 
• Manage Layouts 
• Deactivate Active Layout Sequence 
• Manage Layout Sequences 

Display Pane 
The display pane shows all items within the structure pane selected element. 

 
Figure 26: Display Pane 

Right-click on any of the displayed views to enable features such as: 
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• Video Stream 
• Video Transfer 
• Digital Pan-Tilt-Zoom 

 

Note: 
The feature of the Digital Pan-Tilt Zoom is used by PTZ, which 
is not applicable in this version. 

• Show Detected Motion 
• Copy Current Frame to Clipboard 
• Save Current Frame As … 
• Open Archive … 
• Screen Arrangement 
• Maintain Aspect Ratio 

Events Pane 
In this pane you can view a time and date record of server-client connection. 

 

3.6 Server Configuration 
Now that you are a little more familiar with the software’s main window, you 
are ready to configure the server. 
In this section you learn how to check and modify: 

• Recording  Properties 
• Server Communication Properties 
• Server Watchdog 
• Server User Management 

Recording Properties 
View and modify the hard drive space used by AS-525AV ViTrax software. 

To display recording properties: 
1. From the structure pane, right-click the server name.  
2. Select Tasks  Recording Properties. The Recording Properties dialog box 

opens. 
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Figure 27: Recording Properties Dialog Box – Directories Tab 

The Directories tab displays the available hard drive space and allows 
you to make modifications: 

Path When you check and highlight either drive, the Details 
option below becomes available for further data entry. If 
you do not want the C drive to be used for storage, do not 
check it. If you only want a small portion of the C drive to be 
used, define how much in the Details option. 

Add This button allows you to add external storage addresses for 
recording such as sharing on the remote computer or NAS 
drive. 

Remove This button removes currently selected network storage 
path. 

Path Displays selected path. 
Priority This option allows you choose which of the drives records 

first. 
You must first check and then highlight (by clicking one 
time) the drive you want to customize in this portion. 

Quota This option allows you to select the amount of space you 
would like to designate for storage on that particular hard 
drive.  
Never choose 100% for the C drive. This may cause your 
machine to eventually crash due to not enough available 
virtual memory. 
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The Recording Properties dialog box remains open behind the new 
dialog box. 

3. Click Apply to save the settings. 
4. Click the Statistics tab, which displays the used space and available 

space left on the hard drives being used by AS-525AV ViTrax software. 

 
Figure 28: Statistics Tab 

5. Click View to enable Stored Streams by Source or Stored Streams by 
Location. 

6. Click Refresh at any time for an updated list. 
7. Click Expand to view the Archive Total on a larger screen. 
8. Click OK to save the settings and return to the Recording Properties 

dialog box. 

Server Communication Properties 
View and modify who is connected to the server. 

To open the server communication properties box: 
1. From the structure pane, right-click on the server name. 
2. Select Tasks  TCP Communication Properties. The TCP Communication 

Properties dialog box opens. 
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Figure 29: TCP Communication Properties 

3. Click the Server tab to display the server status. 
Activate This button allows remote users access server over 

network using TCP protocol 
Deactivate This button denies remote access to currently 

connected users 
TCP Port Default is 60554 
Save these settings as 
default 

Check if you want the new settings to be the 
default settings 

4. Click Apply to save the settings. 
5. Click the Connections tab to display who is connected to your server. The 

IP address, user name, and connection time can all be seen.  
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Figure 30: Connections Tab 

Click Refresh at any time for an updated list. 
6. Click OK to save the settings and to close the window. 

Server Watchdog 
The server watchdog performs an important operation, protecting the 
software from improperly working due to system problems. Configuring the 
watchdog is not necessary if you chose to enable it during installation. 
However, if you are having frequent restarts or for maintenance adjusting, 
you may choose to manually configure the watchdog. 

To configure the watchdog: 
1. From the structure pane, right-click on the server.  
2. Select Tasks  Manage Watchdog. The Manage Watchdog dialog box 

opens. 
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Figure 31: Manage Watchdog Window 

3. Highlight Software Watchdog by left clicking one time to activate the 
Enable, Disable, and Properties buttons. 

4. Click Properties. The Software Watchdog Properties dialog box opens. 

 
Figure 32: Software Watchdog Properties Window – State Tab 

5. Click the State tab to stop or start running the watchdog. 
6. Under the Watchdog Options, you have the options to start the 

watchdog with server and to enable the watchdog by checking the 
checkboxes. 
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7. Click Apply to save the settings. 
8. Click the Operation tab to configure the reboot action. 

 
Figure 33: Operation Tab 

9. In the Operation tab, type the amount of time in seconds for the grace 
interval, the amount of time for the reboot interval, and the number of 
failures before the device reboots. 

10. Click Apply to save the settings. 
11. Click the Performance tab to configure which environment performance 

counters and variables determine the necessity of a server or system 
restart.  
The watchdog attempts to restart the server or system after exceeding 
any specified threshold. 
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Figure 34: Performance Tab 

In the Performance tab, you select the following options by checking 
them: 
• Monitor system committed memory usage ratio 
• Monitor system pool non-paged memory usage 
• Monitor server private memory usage ratio 
• Monitor server virtual memory usage 

12. Click Apply to save the settings. 
13. Click the Maintenance tab to set the restart. 
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Figure 35: Maintenance Tab 

 It is recommended you check the Enable periodic restart checkbox. 
Enabling this feature restarts the Server application at times specified.  

14. Click OK to save the settings and to close the window. 

 

Note: 
It is recommended to restart the Server Application to 
refresh system resources. The watchdog server restart goes 
virtually unnoticed by the user. 

Server User Management 
Manage the server user permissions through the Server Security Wizard. This 
wizard guides you step-by-step to add, remove, or modify user permissions. 

To access the server security wizard: 
1. From the structure pane, right-click on the server.  
2. Select Tasks  Server Security Setup Wizard. The Server Security Setup 

Wizard dialog box opens. 
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Figure 36: Server Security Setup Wizard 

3. Click Create a new user to create a new user. 
4. Click Modify an existing user permissions to modify an existing user 

permission. 
5. Click Next to continue the setup. Make sure to be on the user you want 

to use when you proceed. 
The User Details window opens. 

 
Figure 37: User Details Window 

6. The User logon name (case sensitive) should display the user for this setup 
wizard. Write a User password (Case sensitive) and rewrite it under 
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Password confirmation. You have the option to add comments or an E-
mail address of the user before continuing. 

7. Click Next to proceed with the setup wizard. The System Permission 
window opens. 

 
Figure 38: System Permissions Window 

8.  Server administrators can grant or revoke certain permissions on a 
camera-by-camera basis by checking the Configure individual camera 
access permissions checkbox. 

9. Click Next to proceed to the next screen. The Device Permissions window 
opens. 

 

Note: 
The following window, the Device Permissions window, only 
appears if you check the Configure individual camera 
access permissions checkbox. Otherwise, it skips to the 
Action Summary window. 
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Figure 39: Device Permissions Window 

10. After reviewing the device permissions list, check the devices in order to 
grant permission and uncheck the devices in order to revoke permission. 

11. Click Next to proceed to the next screen. The Action Summary window 
opens. 

 
Figure 40: Action Summary Window 

12. This window allows you to review the requested action details before you 
finish the setup wizard. Click Next to continue. 
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Note: 

 
After you click Next in this window, you can no longer click 
Back in the setup wizard. Be certain when you review the 
Action Summary that it is all correct. 

 
13. Click Finish to close the wizard or check Continue with setting up other 

permissions to continue this setup wizard for a different user. 
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4. Configuring Cameras 
You are now ready to set up the cameras. AS-525AV ViTrax supports the AC-
525 connection (in which you can connect your cameras), Arecont® network 
IP cameras, and network (IP) cameras (web cameras). 
This chapter explains how to set up the cameras and how to configure each 
camera via the ViTrax Camera Setup Wizard in order to record video from this 
camera and for motion detection. The panel in the ViTrax software supports 
two cameras. The system can support up to five panels. 
The Camera Setup wizard helps you assign names for each camera, adjust 
the cameras properties (like frame size, etc), select the compression type, 
and setup motion detector and recording settings. 
AS-525AV ViTrax is compatible with the following cameras: 

• AC-525 connection 
• Arecont® network IP cameras 
• Network IP cameras (web cameras) 

 

Note: 
Refer to the AC-525 Hardware manual to see a list of 
recommended, compatible cameras and for instructions on 
the installation process of the AC-525. 

4.1 Setting up AC-525 Connection 
You are now ready to configure the AC-525 to work with AS-525AV ViTrax. 
Each panel supports two cameras. The system can support up to five panels. 

Configuring through the Camera Setup Wizard 
This section explains how to configure each AC-525 to enable video 
recording and for motion detection. 

To configure the AC-525: 
1. From the structure pane, right-click on the server.  
2. Select Tasks  Camera Setup Wizard. The Camera Setup Wizard dialog 

box opens. 
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Figure 41: Camera Setup Wizard Window 

3. From the first window in the wizard select Add new (Rosslare DVR AC525). 
4. Click Next to continue to the next screen. The Camera device properties 

window opens. 

 
Figure 42: Camera Device Properties Window 

5. In Device Title, type the name of device you are adding. 
6. Click Properties to set device specific properties. 
7. Click the Location tab to enter the Network host name or IP address. 
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Figure 43: Location Tab 

8. Click Ping to ping the AC-525 to the selected IP Address. 
9. Select Channel A or Channel B. 
10. Click Apply to save the settings. 
11. Click the USB Storage tab to check the available USB storage. 

 
Figure 44: USB Storage Tab 

12. Click Apply to save the settings. 
13. Click the Time tab to set the panel’s time and date. 
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Figure 45: Time Tab 

14. Click Apply to save the settings. 
15. Click the Video tab to set video resolution, video stream, frame rate, 
and bit rate and to set whether the video streaming comes from Camera 
A or Camera B. 

 
Figure 46: Video Tab 

16. Click OK to save the settings and return to the Camera device 
properties box. 
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17. Click Next to continue with the Camera Setup Wizard. The Video 
compression window opens. 

 
Figure 47: Video Compression Window 

This option allows you to compress video data. Disable or enable server 
side compression. 
After selecting a Compression handler from the dropdown menu, click 
Properties. The JPEF Compressor Properties window opens. 

 
Figure 48: JPEG Compressor Properties 

18. Drag the handle on the Quality slider either left or right to adjust the 
quality of the JPEG compression.  
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Click OK to return to the Video compression window. 
19. Click Next. The Motion analysis window opens.  

 
Figure 49: Motion Analysis Window 

If motion analysis is required, check Use motion detector for stream being 
set up.  
Then click Properties to make the desired settings. The Properties window 
opens. 

 
Figure 50: Sensitivity Tab 

20. Click the Sensitivity tab to adjust the motion detection sensitivity. 
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Figure 51: Exclusion Tab 

21. Click the Exclusion tab and select which cells you want excluded from 
motion detection. 

 
Figure 52: Format Tab 

22. Click the Format tab to select desired resolution, motion smoothing, and 
motion in each cell of a frame. 
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Note: 

 
The higher the motion detection frame rate, the slower the 
CPU processing. 

 
Figure 53: Source Tab 

23. Click the Source tab to select the source of motion detection information 
and software motion detection analysis. 
Click OK to save the settings and return to the Motion analysis window. 

24. Click Next. The Data recording window opens. 

 
Figure 54: Data Recording Window 

This screen allows you to set up data recording properties. 
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Check Video data and click Advanced properties. 

 
Figure 55: Time Lapse Tab 

25. Click the Time Lapse tab. Check Enable time lapse recording if you want 
to record fames with unconditionally restrained recording frame rate. 
Enter the desired frame rate per second (fps). 

 
Figure 56: Motion Control Tab 

26. Click the Motion Control tab to not record frames with no motion 
detected. Check Enable motion controlled recording and enter the 
desired settings. 
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Click OK to save the settings and return to the Data recording window. 
27. Click Global Recording Properties… button. 

 
Figure 57: Directories Tab 

28. Click the Directories tab to select the desired network path to use as 
external storage. 

 
Figure 58: Statistics Tab 

29. Click the Statistics tab to view the archive total. 
Click View to select viewing the stored streams by source or location. 
Click Refresh to refresh the screen. 
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Click Expand to maximize the size of the window. 
Click OK to save the settings and return to the Data recording window. 

30. Click Next. The Action summary window opens. 

 
Figure 59: Action Summary Window 

This screen displays the selected settings. This is the last opportunity to 
change the settings. 
Click Back to change the settings. 

31. Click Next to complete the Camera Setup Wizard. 
32. When the Wizard Completion window opens, click Cancel to exit the 

Camera Setup Wizard if you do not want to preserve any of the settings 
- or - 

Click Finish to exit the Camera Setup Wizard or check Continue with 
setting up another camera to continue this setup wizard for a different 
camera. 

4.2 Setting up Arecont® Network IP Cameras 
There are two ways to set up an Arecont® Network IP camera to work with 
AS-525AV ViTrax: 

• Let the software find the cameras automatically  
• Manually input all of the camera’s IP information 

Configure the Arecont® Network IP Cameras Automatically 
Configure the Arecont® Network IP camera conveniently and reliably 
through the Find Arecont® Vision Network Cameras function. 
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To configure the IP camera automatically: 
1. From the structure pane, right-click on the server. 
2. Select Tasks  Find Arecont® Vision Network Cameras. The Find Arecont 

Vision Network Camera dialog box opens. 

Configure the IP Cameras Manually  
Configure the Arecont®  IP cameras manually through the Camera Setup 
wizard. 

To configure the IP camera manually: 
1. From the structure pane, right-click on the server.  
2. Select Tasks  Camera Setup Wizard. The Camera Setup Wizard dialog 

box opens. 

 
Figure 60: Camera Setup Wizard 

 

Note: 
The Camera Choice screen shows all of the configured 
devices and also has the option to add new devices.  

 
3. Highlight Add new (Arecont® Network (IP) Camera). 
4. Click Next to continue adding the camera. The Camera device 

properties  window opens. 

AS-525AV ViTrax Software Installation and User’s Guide Page 63 



Configuring Cameras 

 
Figure 61: Camera Device Properties Window 

5. Give the device a name under Device title. 
6. Click on the Properties button. The Properties window opens. 

 
Figure 62: Properties Window – Access Tab 

7. Click the Access tab to set camera access settings such as image 
resolution, IP address, port, and image quality. 
Click Apply to save the settings. 
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Figure 63: Frame Tab 

8. Click the Frame tab to set the image dimensions, color mode, image 
brightness, contrast, sharpness, hue, and saturation. 
Click Apply to save the settings. 

 
Figure 64: Colors Tab 

9. Click the Colors tab to set color settings such as illumination and night 
mode. 
Click Apply to save the settings. 
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Figure 65: Iris Tab 

10. Click the Iris tab to set iris preferences such as repositioning time. You 
must check the Auto-Iris checkbox or otherwise everything in this dialog 
box remains grayed out. 
Click Apply to save the settings. 

 
Figure 66: Lens Tabs 

11. Click the Lens tab to set lens preferences such as auto mode, night 
mode, day mode, and full or half image resolution in night mode. 
Click Apply to save the settings. 
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Figure 67: Advanced Tab 

12. Click the Advanced tab to set advanced preferences such as the 
camera model, camera revision, firmware version, client timeout, number 
of pauses between frames, use of double packets, and the power supply 
frequency. 
Click Apply to save the settings. 

 
Figure 68: Crop Tab 

13. Click the Crop tab to set image crop preferences. 
14. Click Apply to save the settings. 
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Figure 69: Motion Detection Tab 

15. Click the Motion Detection tab. Check the Camera-side Motion 
Detection. 

16. Click OK to save the settings and to close the Properties dialog box. The 
Camera Setup Wizard continues when the Properties dialog box closes.  

4.3 Network IP Cameras 
A network IP camera is a digital camera that can be directly connected to 
the Internet through a CAT5 or WiFi connection.  
Network (IP) camera installations are highly scaleable and upgradeable. 
There is no need to buy and install additional video capture boards for the 
AC-525 system in the event you want to add a camera or increase 
performance of the system. There are two ways of setting up a network IP 
camera to work with the AS 525 ViTrax: 

• Let the software find the cameras automatically  
• Manually input all of the camera’s IP information 

Configure the IP Cameras Automatically 
By following the step-by-step Network Scan Wizard, configuring the IP camera 
automatically is the most reliable and convenient way to configure the IP 
camera. 

To configure the IP camera automatically: 
1. From the structure pane, right-click on the server.  
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2. Select Tasks  Find Network Cameras. The Network Scan Wizard dialog 
box opens. 

 
Figure 70: Network Scan Wizard 

3. Select Local Area Network (LAN) search and check Intelligent Camera 
Search. 
If you have chosen Local Area network (LAN) search choose network 
adapters for searching their networks 
     - or -  
If you know the networks IP range, search by the IP address range search 
option for the cameras. 

4. Click Next to continue setting up the IP camera. The Scan Options 
window opens. 
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Figure 71: Scan Options Window 

5. Check the Intelligent camera search checkbox if you want a more 
thorough network search. Then click Next to begin the network scan. 

 

Note: 
Intelligent camera search may take several minutes to be 
completed and may not work properly if access to the 
camera is restricted by username and password. 

 
AS-525AV ViTrax now begins to scan the network and specified ports for 
any IP cameras. Once it is finished it gives you a list of the cameras that it 
found and the option to add them to AS-525AV ViTrax system. 

Configure the IP Cameras Manually  
Through the Camera Setup wizard, you can add and configure the IP 
cameras manually. 

To configure the IP camera manually: 
1. From the structure pane, right-click on the server.  
2. Select Tasks  Camera Setup Wizard. The Camera Setup Wizard dialog 

box opens. 
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Figure 72: Camera Setup Wizard Window 

3. From the first window in the wizard select Add new Network (IP) Camera. 
4. Click Next to continue to the next screen. The Camera device properties 

screen opens. 

 
Figure 73: Camera Setup Wizard 

5. In Device Title, type the name of the name of the camera you are 
adding. 

6. Click Properties to set device specific properties. 
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Figure 74: Device Properties 

7. Click the Access tab to access the available cameras. 
Select the camera type that you are using from the drop-down menu in 
Network (IP) Camera Type and specify the model (not necessary).  

- or - 
If you are using an IP server, select from the same menu. Then select the 
camera input from the Advanced tab. 
In IP Address, type the IP address of the IP camera and type in your 
username and password. 

8. Click Apply to save your settings. 
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9. Click the Frame tab to define the quality of the picture. 

 
Figure 75: Frame Tab 

In Dimensions, select the format you want. The higher quality chosen, the 
more space it takes. 
In Color Mode, choose to see the images in color or black and white. 
Under Image Adjustment, Brightness, Contrast, Sharpness, Hue, and 
Saturation options change the appearance of the video quality. 

10. Click Apply to save your settings. 
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11. Click the Image tab to set the image properties. 

 
Figure 76: Image Tab 

Operation mode • M-JPEG(stream) 
• JPEG 

Image quality From Min to Max 
Flip image Autodetect, No flip, Flip, Rotate 90 degrees, 

Rotate 270 degrees 
  
12. Click Apply to save your settings. 

 

Note: 
Min quality gives higher image compression ration and 
higher FPS rates. 
If the Default quality checkbox is checked, you cannot 
adjust the Image quality. 
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13. Click the Advanced tab to set the camera parameters and video server. 

 
Figure 77: Advanced Tab 

Camera specific parameter <default>, Axis old firmware, Axis 
NTSC format, Axis PAL format 

Output video channel <default>, 1, 2, 3, 4, 5, 6, 7, 8  
  
14. Click Apply to save your settings. 
15. Click the Global tab to set global settings for all network cameras such as 

connection timeout, amount of time between frames, and specific proxy 
settings. 
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Figure 78: Global Tab 

16. Click Apply to save your settings. 
17. Click the JPEG Compatible tab to make the image JPEG compatible. 

 
Figure 79: JPEG Compatible Tab 

18. Click OK save your settings and to continue with the Camera Setup 
Wizard.  
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5. Setting System Options 
You can modify the system's options for AS-525AV ViTrax such as the screen 
options, screen mapping, miscellaneous, exclusivity, and sound options. 

To set system options: 
1. From the File menu bar, click Tools  Options. The Options window 

opens. 

 
Figure 80: Screen Tab 

Screen Tab 
With the Screen tab selected, select the following screen options: 
Video renderer version • Default (DirectX 7) 

• DirectX 9 
• DirectX7 
• Legacy DirectX 
• GDI 

Preferred Screen Size 50%, 100%, 200% 
Resolution abbreviations • Abbreviate when possible 

• Don’t abbreviate 
Downsample large images • Default 

• Disabled 

AS-525AV ViTrax Software Installation and User’s Guide Page 77 



Setting System Options 

• Enabled, Favor Quality 
• Enabled, Favor Speed 
 

2. Click the Screen Mapping tab to define camera to screen mapping. 

 
Figure 81: Screen Mapping Tab 

Screen Mapping Tab 
With the Screen Mapping tab selected, select the following screen 
options: 
Automatic Mapping mode • Automatic – camera is mapped to 

screen automatically 
• Disabled 

Save Last Mapping Mode • Per Arrangement 
• Automatic 
• Disabled 

Pause live data while 
archive window is opened 

It is recommended you check this 
option 

3. Click the Miscellaneous tab to set application options and structure 
pane options. 
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Figure 82: Miscellaneous Tab 

Miscellaneous Tab 
With the Miscellaneous tab selected, select the following screen options: 
Startup window mode • Normal Window 

• Always Full Screen 
Expand items on 
population 

• None 
• Server 
• Server and Category 

Server double-click action • Connect to Server 
• Show Properties 

  
4. Click the Exclusivity tab to set exclusivity rights, passwords, and startup 

options. 
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Figure 83: Exclusivity Tab 

AS-525AV ViTrax includes safety features that prevent human error by 
allowing access to AS-525AV ViTrax. These features include: 
• Exclusivity Mode (Windows lock out feature) 
• Lock Application 

Exclusivity Tab 
With the Exclusivity tab selected, select the following screen options: 
Password • Type in any password 

• Check whether you want to Request comfirmation 
before lock. 

• As you type in the password, the Startup Lock will 
not be grayed out. 

Enable 
exclusive 
mode 

By enabling the exclusive mode, you can only use 
the computer for surveillance purposes and cannot 
use the internet or other programs. 

Startup • Manual start 
• Automatic with any user logon 
• Automatic with current user logon 

Startup Lock • Start unlocked 
• Start locked 
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The exclusivity mode is a safety feature that prevents the user from having 
access to Windows operating system. Enabling this feature allows the user 
access to AS-525AV ViTrax software only. This ensures uninterrupted server 
operation and stability, eliminating human error. 

Lock Application 
AS-525AV ViTrax Client can be locked to ensure that no one has access to 
server settings except the administrator. The exclusivity mode password is 
used to unlock the application.  

To enable lock application: 
1. From the File menu, click Tools  Lock Application. The lock application 

is now enabled. 

 

Note: 
A warning window appears when you click Lock 
Application and says "The application will be locked until 
exclusivity mode password is provided to unlock. Would you 
like to unlock now?"  

 
The following prompt screen appears. 

 
Figure 84: Password Prompt 

2. Type in the same password you already chose in the Exclusivity tab. 

 

Note: 
The unlock password prompt window appears and 
becomes semi-transparent or hidden while the keyboard 
input is idle. Everything on the screen will be grayed out so 
that no one can use the computer while you are not 
present. Start typing the password and the password 
prompt window reappears on the screen. 

 
3. Click the Sounds tab to attach sound files to specific events. 
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Figure 85: Sounds Tab 

Sounds Tab 
Under the Sounds tab, you are able to set the sound .wav files that will 
indicate the following events: 
• Disconnection from Server (Failure) 
• Video Source Motion 
• Disconnection from Server (Success) 
• Connection to Server 
You can browse your computer or the internet to add such .wav files. 

Make sure to click Apply if you have made any changes to the system's 
options. To exit at any point, click Cancel. 
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6. AS-525AV ViTrax Video Capabilities 
Now that the software is installed and the cameras have been configured, 
you are ready to learn some of the software’s capabilities. 
In this chapter, you learn about the following features: 

• Making Video Adjustments 
• Exporting Video Frames 
• Enabling Video Transfer 
• Creating Custom Layouts 
• Map Module Feature 
• Archiving Integrity Wizard 
• Archiving Backup Wizard 
• Playback Video 
• Exporting Video 

6.1 Making Video Adjustments 
Adjust every individual camera with its own settings through the video 
adjustment feature. The following settings can be adjusted: 

• Brightness 
• Contrast 
• Saturation 
• Sharpness 
• Hue 

To make video adjustments: 
1. Click the Video Amplification icon on the toolbar. 

 
Figure 86: Video Amplification Icon 

The Video Adjustment screen opens. 
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Figure 87: Video Adjustment Screen 

2. Slide the handles left or right to adjust the settings 

6.2 Exporting Video Frames 
The Video Frame Export Setup Wizard allows you to configure continuous 
saving of video frames on network, fixed storage, or an FTP. Frame exports 
can be configured for multiple devices. Exported frames are saved in JPEG 
format using the filename format you specify when configuring the export 
until it is disabled.  

To run the Video Frame Export Setup Wizard: 
1. Right-click on the appropriate server in the structure pane. 

- or - 
Select menu item Server Selected Server. 
2. Click Tasks. 
3. In the submenu, click Video Frame Export Setup Wizard. 
4. When the Welcome to the Video Frame Export Setup Wizard opens, click 

Next to continue the installation. The Video Streams window opens. 
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Figure 88: Video Streams Window 

5. Select one or more devices from the list for frame export configuration. 
From this screen, enable or disable the video frame export. 
If you want to enable export, click Properties to configure it.  
The Export Properties window opens.  
After you have configured the profiles, continue with the wizard 
installation. (See Complete the Video Frame Export Setup Wizard on 
page 88.) 

Configure Profile Properties 
The Profile Properties allows you to configure the profile settings to export the 
video frames. 

There are two types of profiles:  
• file export—prepares the video frames for export to a file 
• FTP export —prepares the video frames for export to an FTP site 

There are four tabs in the Properties window: 
File Select a profile from available list or configure a new profile 

using the Manage button 
Format Configure the video effects and compression options. 
Time Lapse Process frames while constraining the frame rate.  Enable 

the time lapse to lower the CPU load and leave more CPU 
time for other tasks. 

Motion 
Control 

Motion Control provides an opportunity to process data 
when only motion is detected. 
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Figure 89: Export Properties Window 

1. In the Profile area, select an already created profile or create at least 
one to start using video frame export. 

2. In the File Name Template area, select a name from the dropdown 
menu or choose another name. 
Each frame is saved in a file with a template string used for formatting the 
filename.  

 

Note: 
Make sure the filename is unique by adding it's time in ms or 
random unique string ($(Ms) or $(Unique) format tags). 

3. Click the Manage button to create, edit, or delete profiles used to export 
video frames. 

 

Note: 
Reconfiguration of a profile affects all video streams the 
profile is selected for. 

  
The Profiles Property window opens. 
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Figure 90: Profiles Properties Window 

In the Profile Title area, you can edit or delete already created profiles. 
4. Click Create to open the dropdown menu displaying the export video 

frames location choice. Choose from the following: 
• File Export Profile 
• FTP Server Profile 

File Export Profile 
The File Export Profile allows you to export the video frame to a file or 
directory. 
1. Click File Export Profile. 
2. When the Write to File window opens, specify the desired frame export 

directory, network storage, or share path in Directory or Browse for the 
relevant directory. 

 

Note: 
If you are connected remotely, it is important to remember 
that this is the server side directory. 

3. Click OK to save the settings and return to the Profiles Properties window. 

FTP Server Export Profile 
The FTP Server Export Profile allows you to export the video frames to an FTP 
site. 
1. Click FTP Server Export Profile. 
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2. When the FTP Server Export Profile window opens, fill in the appropriate 
settings to allow Rosslare to connect and save frames here.  

3. Click OK to save the settings and return to the Profiles Properties window. 

Complete the Video Frame Export Setup Wizard 
1. Click Next to continue the installation. The Action Summary window 

opens. 
This page of the Video Frame Export Setup Wizard gives you a summary 
of all of the changes that you have made throughout the wizard. 

2. Click Next to continue the installation. The Wizard Complete window 
opens. 
Congratulations, you have now setup export of frames for the camera(s). 

3. Click Finish to end the Video Frame Export Setup Wizard. 

6.3 Enabling Video Transfer 
The video transfer feature allows you to reduce network traffic between AS-
525AV ViTrax Server and AS-525AV ViTrax Client (if remotely connected) 
and/or to decrease CPU load on the client side.  
Video transfer reduces the amount of data transferred from server to client by 
skipping some frames, transferring only motion detected frames, and 
recompressing or down sampling them without reducing recorded data 
quantity and quality.  
This feature is useful in slow remote connections or highly loaded networks 
when viewing cameras remotely. It effectively decreases image resolution or 
transfer fps on low-end systems, where AS-525AV ViTrax client is used for 
viewing large numbers of cameras. This approach reduces resolution and 
number of frames, waiting to be rendered on the screens. 

To enable video transfer feature: 
1. From the File menu, click Video  Transfer. 

The Video Transfer Properties window opens. 
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Figure 91: Video Transfer Properties Window 

2. In the Time Lapse & Bandwidth Control area, only check Enable time 
lapse broadcast checkbox on the remote connection if needed. 

3. Check Enable bandwidth controlled broadcast if needed to adjust data 
controlled broadcast. 

4. In the Motion Controlled Broadcast area, check Enable motion controlled 
video transfer remotely if you want to see video on motion only. 
This is very helpful because frame rate is distributed to the cameras that 
have motion only. 

5. Check Enable video transfer recompression. 

 

Note: 
Vide transfer recompression is useful for remote connections 
only. 

 
AS-525AV ViTrax can usually record up to three mega pixel images. This 
feature allows the user to increase the frame rate with less image quality 
without changing the server properties. 

6. Click OK to save the settings. 
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Specify Transfer Defaults for Newly Added Devices 
Specify default values of the transfer defaults for newly added devices. All 
options are identical to the Video Transfer properties. 

To specify transfer defaults: 
1. Right-click on the server in the structure pane. 
2. Click Properties. The Properties window opens. 
3. Click the Video Transfer Defaults tab. 

 
Figure 92: Video Transfer Defaults Tab 

4. Set the desired properties in the following areas: 
• Time Lapse 
• Bandwidth Control 
• Motion Control 

5. After selecting the settings, click OK. 

6.4 Creating Custom Layouts 
Create custom layouts by grouping cameras from different AS-525AV ViTrax 
servers/locations into groups for more efficient monitoring and better 
management. 
For example, you can group together all out-door cameras from different 
location or all POS cameras from all registers. 
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Note: 

 
By default, empty screens are filled with available cameras. 
You can disable the automatic mapping mode feature 
through the Screen mapping tab in Options. 

 

To create custom layouts: 
1. Right-click on Layouts in the structure pane. 

 
Figure 93: Layouts 

There are four options in the dropdown menu: 
• Save Current Layout 
• Manage Layouts 
• Deactivate Active Layout Sequence 
• Manage Layout Sequences 
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Save Current Layout 
View and select the current layout in the Structure Pane tree-view. The 
selected view opens in the Display Pane. 
Also access this feature from the menu bar as follows: 

To save current layout: 
1. Click View  Select the Save Current Layout. The Layouts window opens. 

 
Figure 94: Layout List Window 

2. Modify the current layout by selecting the Current Layout in the Name 
box and using the following buttons to make the changes: 

Rename Renames current layout 
Set Startup Program opens with this layout when starting up 
Delete Deletes current layout 
Activate Activates current layout 

Create New Layout Sequence 
When layouts are created, they can be used for sequencing.  

To create sequences: 
1. Right-click on Layout. 
2. Click Manage Layout Sequences from the submenu. 

The Layout Sequences window opens. 
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Figure 95: Layout Sequences Window 

3. Click New to create a new sequence. The Layout Sequence Properties 
window opens. 

 
Figure 96: Schedule Window 

4. Click the Schedule tab. 
5. Click Add or Remove to add or remove sequences. 
6. Click Move Up or Move Down to manage priority or remove layouts of 

the choice. 
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7. In the Layout area, choose existing layouts from the dropdown menu to 
add to a sequence. 

8. In Pause, set the time interval between layouts. 
9. After completing the desired settings, click OK. 

6.5 Map Module Feature 
The map module feature allows you to quickly and conveniently locate 
cameras for viewing placed on Google Map and/or on the own floor plans 
added in JPEG format. 

To start the map module feature: 
1. Click the map icon on the toolbar. 

 
Figure 97: Map module icon 

AS-525AV ViTrax Maps window opens. 

 
Figure 98: AS-525AV Maps Window 

Use the navigational tools to navigate around the map. 
Pan up, pan down ,  
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Pan left, pan right ,  
Return to the last result  
Zoom in, Zoom out slider 

 
Use the view buttons on the map to display different views of the map 

Map Shows a street map 
Satellite Shows satellite imagery 
Hybrid Shows satellite imagery with street names 

 
2. Right-click on the map and use context menu commands to configure 

and control map features. 

 
Figure 99: Context Menu Commands 

Add New Camera Marker This option adds a camera marker 
in designated menu (See Add New 
Camera Marker below) 

Goto Map Navigate to other maps in 
appeared list 
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Create New Map From File Add new map from JPEG image file 
to be used as background 

Fit To Window The JPEG map strains on the 
window while maintaining its 
aspect ratio 

Save Current Position Used in Google map to save its 
current position 

Set Current Map As Startup Sets current map as startup map. 
Selected map loads when viewing 
this map module 

Rename Current Map Rename currently selected map 
Remove Current Map Delete currently selected map 

Add New Camera Marker 
1. After choosing this menu option, select from a list of servers and cameras.  
2. After adding new marker, double click on the marker to activate the 

matching camera.  

 
Figure 100: Add New Camera Marker 

 3. To remove the marker, right-click on the marker and choose according 
to popup menu item. 
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6.6 Archiving Integrity Wizard 
Archive Integrity Wizard repairs parts of damaged archive data that was lost 
due to power losses or hardware problems.  
Lost data cannot be repaired using this wizard, but the wizard finds and 
removes damaged parts of the archive to restore archive structure and 
functionality. However you should check third party tools which can be used 
for repairing hard drive sectors and/or recovering bad sectors.  
This wizard can also delete specific stream from the archive.  

 

Note: 
This wizard works only on the same machine where AS-
525AV ViTrax server is installed. 

 

To run the Archive Integrity wizard: 
1. From the Start menu, click the Rosslare menu folder. 
2. Click Tools in the subfolder. 
3. Select DVR Server Archive Integrity Wizard. When the Introduction to the 

Archive Integrity Wizard opens, click Next to continue.  
If AS-525AV ViTrax server is running on the same machine, an additional 
page opens. 
You need to decide to either stop the server or continue using this wizard 
without terminating the server.  

 

Note: 
It is recommended that you terminate the server before 
using the wizard for the wizard requires exclusive access to 
the archive files. 

 
If you do not want or are unable to terminate the server, try using this 
wizard on the archive on one drive while the server is writing it on another 
drive.  

4. Select one or more archives from the list.  

 

Note: 
If any file in the archive is locked by another process, the 
entire archive on this drive is marked “locked” and is not 
selectable. 

 
The Archive Location Selection window opens. 
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Figure 101: Archive Location Selection 

Rosslare recommends that you check Fast scan mode. Fast scan scans 
archive metadata only. 

5. Click Next to continue the wizard. The Preliminary scan review window 
opens. 

 
Figure 102: Preliminary Scan Review Window 

This screen displays information about archive errors and warnings.  
6. Click Repair to delete unreferenced files, unused records, or damaged 

records. 
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Unreferenced files Deletes files not used by AS-525AV ViTrax 

archive 
Unused records Deletes records in files not used by AS-525AV 

ViTrax archive and marked as deleted 
Damaged records Deletes damaged records 

- or - 
Click Delete archive (s) or stream(s) to delete streams or archives. 

- or - 
Click Do nothing, finish Wizard to exit from the wizard. 

7. Click Next to continue the wizard. The Select archives or streams to 
delete window opens. 

 
Figure 103: Select Archives or Streams to Delete Window 

Select stream to be deleted from the archive list. 
8. Click Next and then Finish to finish running the Archive Integrity wizard. 

6.7 Archiving Backup Wizard 
The purpose of the Archive Backup wizard is to backup specific parts of the 
archive or burn CD/DVD with the archive and Archive Viewer on it. This can 
be useful to create backup copies of the archive with lower fps, or writing 
specific part of the archive on the CD for other machines without AS-525AV 
ViTrax installed on them.  
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Note: 

 
This wizard works only on the same machine AS-525AV 
ViTrax server is installed. 

 

To run the Archive Integrity wizard: 
1. From the Start menu, click the Rosslare menu folder. 
2. Click Tools in the subfolder. 
3. Select DVR Server Archive Backup Wizard. When the Introduction to the 

Archive Backup Wizard opens, click Next to continue the Archive Backup 
wizard. The Select cameras to backup window opens. 

 
Figure 104: Select Cameras to Backup Window 

4. Select one or more cameras you want to backup from the list.  
In the Estimate area, you can see estimates of original archive size and 
estimated backup size on every page in this wizard.  
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Note: 
You can decrease the estimate size by deselecting some of 
the cameras, changing the time range. Or decreasing fps 
(frames per second) of archives already backed up. 

5. Click Next to continue the wizard. The Time Selection screen opens. 

 
Figure 105: Time Selection Window 

6. Enter a start and stop time to change a time range. 
7. Click Advanced to decrease the backup of FPS. The Advanced Backup 

Options window opens. 

 
Figure 106: Advanced Backup Options 

8. In Maximum FPS, enter a number smaller than the displayed number to 
decrease the backup of FPS. 

9. Click OK to save the settings and return to the Time selection window. 
10. Click Next to continue the wizard. The Backup Destination window opens. 
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Figure 107: Backup destination Window 

11. Select backup type by clicking Copy archive onto hard or network drive.  
12. In Location area, enter desired location to store backup or browse to 

select a location. This is a fixed storage backup destination location. 
- or - 

 
Click Write on CD/DVD. 
In the Drive area, enter desired drive to store backup or browse to select 
a drive. 
Click Properties to set CD/DVD burning options. The Advanced CD/DVD 
Options window opens. 

 
Figure 108: Advanced CD/DVD Burning Options Window 

In Temporary CD/DVD image file location, enter a file location or browse 
to select a location. 
In Burning library, select either Nero Burning ROM (requires NERO to be 
installed) or IMAPI. 
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After completing the settings, click OK to return to the Backup destination 
window. 

13. Click Next to continue to the Backup wizard finish screen. 

6.8 Playback Video 
Playback the recorder videos with the playback feature. 

To playback the recorder video: 
1. Right-click on the server name in the structure pane. 
2. Select Tasks  Open archive 

or 
Right-click on any camera view and select Open archive. The Archive 
window opens. 

 
Figure 109: Playback Screen 

Understand the Playback Screen 
Now that you are in the playback screen, the structure pane on the left lists 
all of the cameras that you have recordings for. 
Double click on the camera for playback. This camera now appears with 
footage on the video screen. 
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The Playback screen contains the following: 
Color coded time line The solid green line on the bottom 

represents time. The light green lines 
represent recorded video. The orange 
lines represent motion information.  

VCR basic controls 

 

There are basic VCR controls on the 
bottom of the playback screen, which 
you can use to play, pause, forward, 
and rewind. 

Job dial 

 

You can drag in either direction to 
browse through the video in high 
speeds.  

Fast forward arrow controls 

 

Use the arrow controls on top of the 
screen to define how many 
increments of time you would like to 
move through the video or select from 
the dropdown menu: 
• 1 Second 
• 10 Seconds 
• 1 Minute 
• 10 Minutes 
• 1 Hour 

Playback motion 

 

Use these previous motion or seek 
next motion buttons to seek video with 
actual motion in order to save time 

Smart search You can search the screen through 
video and also by motion in a specific 
part of the camera screen.  
You can define a specific object in 
the view, or define a path, and seek 
through motion only in that specific 
region. 

Define motion of interest Select a specific area on the screen 
to define motion (See below) 

To define motion of interest: 
1. From the menu bar click Navigation  Define Region of Motion 

Interest. 
The Region of Motion Interest toolbox opens. 
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Figure 110: Region of Motion Interest Toolbox 

2. Click the seek to previous motion or seek to next motion icons to 
search through motion in the defined area or areas. 

6.9 Exporting Video 
Use the Export wizard to export video. To prevent the section of recordings 
you want to export from being overwritten, first select the recordings you 
want to export to a different location before running this wizard. 

To run the Export wizard: 
1. Click Edit on the playback screen. 
2. Click Export Wizard. 

The Video Stream window opens. 
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Figure 111: Video Stream Window 

3. In Video Stream, enter the camera you want to import video stream 
from or select from the dropdown menu. 

4. In Format, select from the following options: 
• Regular compression 
• Keep original compression 
• Regular compression 
• No compression (raw frames) 

5. Click Next to continue the wizard. The Export Options window opens. 

 
Figure 112: Export Options 

This screen allows you to specify export procedure options. 
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In the Start and Stop Time area, select the start and stop times of the 
video clip you want to export. 

6. Click Next to continue the wizard. The Wizard guides you to designate 
which drive or folder to save the export video in. 

Note: 

 
To play back the Rosslare AVI file, you must install a codec 
(small executable file) in order for the media player to 
recognize AS-525AV ViTrax video file.  
Contact Technical Support at  +972 3 938-6838 

Export Snapshots 
Another way to export video is to save one frame at a time, like a 
snapshot. 

To export snapshots: 
1. Use the VCR basic control tools in the playback screen to pause the 

video on the picture you want to copy. 
2. From the File menu, click Edit  Save Current Frame As… 
3. Select a location and filename for the image. 
4. Click Save.  

Now you have the image stored in order to print, e-mail, or enhance 
that snapshot. 
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7. Upgrading AS-525AV ViTrax Software 
To check for upgrades and new versions contact Rosslare Technical 
Support on +972 3 938-6838 or at support.na@rosslaresecurity.com. 
Updating the software requires all AS-525AV ViTrax services to stop before 
Installation. 
During the installation of the new version you may encounter a message 
with regards to previous installation configurations, if applicable. 
Specifically, would you like to use existing database? 
1. Click Yes to keep all current configurations of the server. This is the 

recommended option. 
or 

2. Click No to start a new database. All previous settings and 
configurations are erased and a new database is created. 
Continue with the installation (see Installing AS-525AV ViTrax PC 
Software on Page 9.) 
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Appendix A 

Appendix  A.      Limited Warranty 
 
ROSSLARE ENTERPRISES LIMITED S (Rosslare) TWO YEARS LIMITED 
WARRANTY is applicable worldwide. This warranty supersedes any other warranty. 
Rosslare's TWO YEARS LIMITED WARRANTY is subject to the following conditions: 
 

Warranty 
Warranty of Rosslare's products extends to the original purchaser (Customer) of the 
Rosslare product and is not transferable. 
 

Products Covered By This Warranty and Duration 
ROSSLARE ENTERPRISES LTD. AND / ORSUBSIDIARIES (ROSSLARE) warrants 
that the AS-525, to be free from defects in materials and assembly in the course of 
normal use and service. The warranty period commences with the date of shipment to 
the original purchaser and extends for a period of 2 years (24 Months). 
 

Warranty Remedy Coverage 
In the event of a breach of warranty, ROSSLARE will credit Customer with the price of 
the Product paid by Customer, provided that the warranty claim is delivered to 
ROSSLARE by the Customer during the warranty period in accordance with the terms 
of this warranty. Unless otherwise requested by ROSSLARE ENTERPRISES LTD. 
AND / OR SUBSIDIARIES representative, return of the failed product(s) is not 
immediately required. 
If ROSSLARE has not contacted the Customer within a sixty (60) day holding period 
following the delivery of the warranty claim, Customer will not be required to return the 
failed product(s). All returned Product(s), as may be requested at ROSSLARE 
ENTERPRISES LTD. AND /OR SUBSIDIARY’S sole discretion, shall become the 
property of ROSSLARE ENTERPRISES LTD. AND /OR SUBSIDIARIES. 
To exercise the warranty, the user must contact Rosslare Enterprises Ltd. to obtain an 
RMA number after which, the product must be returned to the Manufacturer freight 
prepaid and insured 
In the event ROSSLARE chooses to perform a product evaluation within the sixty (60) 
day holding period and no defect is found, a minimum US$ 50.00 or equivalent charge 
will be applied to each Product for labor required in the evaluation. 
Rosslare will repair or replace, at its discretion, any product that under normal 
conditions of use and service proves to be defective in material or workmanship. No 
charge will be applied for labor or parts with respect to defects covered by this 
warranty, provided that the work is done by Rosslare or a Rosslare authorized service 
center. 
 

Exclusions and Limitations 
ROSSLARE shall not be responsible or liable for any damage or loss resulting from 
the operation or performance of any Product or any systems in which a Product is 
incorporated. This warranty shall not extend to any ancillary equipment not furnished 
by ROSSLARE, which is attached to or used in conjunction with a Product, nor to any 
Product that is used with any ancillary equipment, which is not furnished by 
ROSSLARE. 
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This warranty does not cover expenses incurred in the transportation, freight cost to 
the repair center, removal, or reinstallation of the product, whether or not proven 
defective. 
Specifically excluded from this warranty are any failures resulting from Customer's 
improper testing, operation, installation, or damage resulting from use of the Product 
in other than its normal and customary manner, or any maintenance, modification, 
alteration, or adjustment or any type of abuse, neglect, accident, misuse, improper 
operation, normal wear, defects or damage due to lightning or other electrical 
discharge. This warranty does not cover repair or replacement where normal use has 
exhausted the life of a part or instrument, or any modification or abuse of, or 
tampering with, the Product if Product disassembled or repaired in such a manner as 
to adversely affect performance or prevent adequate inspection and testing to verify 
any warranty claim. 
ROSSLARE does not warrant the installation, maintenance, or service of the Product. 
Service life of the product is dependent upon the care it receives and the conditions 
under which it has to operate.  
In no event shall Rosslare be liable for incidental or consequential damages. 
 

Limited Warranty Terms 
THIS WARRANTY SETS FORTH THE FULL EXTENT OF ROSSLARE ENTERPRISES 
LTD. AND IT’S SUBSIDIARIES’S WARRANTY 
THE TERMS OF THIS WARRANTY MAY NOT BE VARIED BY ANY PERSON, WHETHER 
OR NOT PURPORTING TO REPRESENT OR ACT ON BEHALF OF ROSSLARE. 
THIS LIMITED WARRANTY IS PROVIDED IN LIEU OF ALL OTHER WARRANTIES. ALL 
OTHER WARRANTIES EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, ARE SPECIFICALLY EXCLUDED. 
IN NO EVENT SHALL ROSSLARE BE LIABLE FOR DAMAGES IN EXCESS OF THE 
PURCHASE PRICE OF THE PRODUCT, OR FOR ANY OTHER INCIDENTAL, 
CONSEQUENTIAL OR SPECIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS 
OF USE, LOSS OF TIME, COMMERCIAL LOSS, INCONVENIENCE, AND LOSS OF 
PROFITS, ARISING OUT OF THE INSTALLATION, USE, OR INABILITY TO USE SUCH 
PRODUCT, TO THE FULLEST EXTENT THAT ANY SUCH LOSS OR DAMAGE MAY BE 
DISCLAIMED BY LAW. 
THIS WARRANTY SHALL BECOME NULL AND VOID IN THE EVENT OF A VIOLATION 
OF THE PROVISIONS OF THIS LIMITED WARRANTY. 
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Appendix  B.      Technical Support 
Asia Pacific, Middle East, Africa 

Rosslare Security Products Headquarters 

905-912 Wing Fat Industrial Bldg, 

12 Wang Tai Road, 

Kowloon Bay Hong Kong 

Tel: +852 2795-5630 

Fax: +852 2795-1508 

E-mail: support.apac@rosslaresecurity.com

 

United States and Canada 
1600 Hart Court, Suite 103 

Southlake, TX, USA 76092 

Toll Free:+1-866-632-1101 

Local:+1-817-305-0006 

Fax: +1-817-305-0069 

E-mail: support.na@rosslaresecurity.com

 

Europe 
Global Technical Support & Training Center 

HaMelecha 22 

Rosh HaAyin, Israel 48091 

Tel: +972 3 938-6838 

Fax: +972 3 938-6830 

E-mail: support.eu@rosslaresecurity.com

 

South America 
Pringles 868, 1640 Martinez 

Buenos Aires 

Argentina 

Tel: +54 11 4798-0095 

Fax: +54 11 4798-2228 

E-mail: support.la@rosslaresecurity.com

Web Site: www.rosslaresecurity.com
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